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« Global Technical Assistance Center (GTAC) for Immediate Support
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Deploying the Virtual Engine ona VMware ESX Server

Engine Deployment

This chapter provides an overview of ExtremeCloud 1Q - Site Engine, ExtremeControl, and
ExtremeAnalytics virtual engine deployment requirements and provides instructions for
deploying a virtual engine on a VMware® and Hyper-V server.

Deploying the Virtual Engine on a VMware ESX Server

Deployment Requirements

A virtual engine is a software image that runs on a virtual machine. The ExtremeCloud |1Q - Site
Engine, ExtremeControl, and ExtremeAnalytics virtual engines are packaged in the . oVA file
format defined by VMware and must be deployed ona VMware ESXi™ 6.0 server with a
vSphere™ client, orona VMware ESXi™6.5,6.7, or 7.0 server using the web client.

Forinformation about the different ExtremeCloud 1Q - Site Engine, ExtremeControl, and
ExtremeAnalytics virtual engine configurations, see the latest ExtremeCloud 1Q - Site Engine
Release Notes.

Deploying the Virtual Engine

Use the following steps to deploy an ExtremeCloud |Q - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine ona VMware ESX or ESXiserver.

1. Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or ExtremeAnalytics virtual engine
software image to your local machine where the client is installed and running.

To download an engine image:

1. Access the Extreme Portal at: https://extremeportal.force.com/.

After entering your email address and password, you are on the Support page.
Select the Products tab and select ExtremeManagement.
Select ExtremeCloud IQ - Site Engine in the right-panel.

Select a version.

S

Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or ExtremeAnalytics virtual
engine (appliance) image from the appropriate section.
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Deploying the Virtual Engine ona VMware ESX Server
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2. Openthe VMWare software. From the Host menu, select Create/Register VM.
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3. From the Select creation type panel, select Deploy a virtual machine from an.OVF or .OVA file. Select
Next.
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4. Enter the name of the virtual machine and select the .OVA file. Select Next to continue.
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5. Select your datastore. Select Next to continue.
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6. Select your deployment options and select Next.
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Deploying the Virtual Engine on a Hyper-V Server

7. Review and select Finish to start the deployment.
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After the OVA file has finished uploading and importing, you are now ready to begin configuring
the engine.

Shutting Down the Engine

To properly shut down the virtual engine, enter the following command at the login promptin

the vSphere client Console tab:
poweroff

This shuts down the engine and updates the vSphere client with the new engine state.

Deploying the Virtual Engine on a Hyper-V Server

Deployment Requirements

A virtual engine is a software image that runs on a virtual machine. The , ExtremeCloud |Q - Site
Engine, ExtremeControl, and ExtremeAnalytics virtual engines are packaged in the .ZIP file
format and must be deployed on a Microsoft Hyper-V server.

Deploying the Virtual Engine

Use the following steps to deploy an ExtremeCloud IQ - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine ona VMware ESX or ESXiserver.
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Deploying the Virtual Engine on a Hyper-V Server

1. Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or ExtremeAnalytics virtual engine
software image to your local machine where the vSphere client is installed and running.

To download an engine image:

1.

I

Access the Extreme Portal at: https://extremeportal.force.com/.

After entering your email address and password, you are on the Support page.
Select the Products tab and select ExtremeCloud 1Q - Site Engine.

Select ExtremeCloud IQ - Site Engine in the right-panel.

Select a version.

Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or ExtremeAnalytics virtual
engine (appliance) image from the appropriate section.

Extreme Portal Support Products Partners

Software & Downloads ~

Release Notes il

2. Extract the virtual engine file to a local directory.

3. Openthe Hyper-V Manager.

4. From the Action menu, select Import Virtual Machine.

Nof59


https://extremeportal.force.com/

Deploying the Virtual Engine on a Hyper-V Server
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Bt isk.. [ Hyper-V Settings...
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7 Remove Server
4 Refresh
View »
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Details
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Displays the Import Wizard.

The Import Virtual Machine wizard opens to the Before You Begin panel.

Before You Begin

This wizard helps you import a virtual machine from a set of configuration files. It guides you through
resolving configuration problems to prepare the virtual machine for use on this computer,

Locate Folder

Select Virtual Machine
Choose Import Type

Summary

["] Do not show this page again

< Previous | | MNext > | | Finish | | Cancel

Select Next.
The Locate Folder panel opens.
Select the Browse button and navigate to the folder where you saved the engine image.

Select Select Folder, and then Next.
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Deploying the Virtual Engine on a Hyper-V Server

(] Import Virtual Machine
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The Select Virtual Machine panel opens.

8. Select the virtual machine you are importing, and then select Next.

» Select Virtual Machine

Befaore You Begin Select the virtual machine to import:
Locate Folder -
Name
irtual Machine

Date Created
2/6/2015 8:07:58 PM

nac_appliance_64bit.5.2.0.189

Choose Import Type

Summary

< Previous | | Mext = | | Finish | | Cancel

The Choose Import Type panel opens.
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Deploying the Virtual Engine on a Hyper-V Server

Import Virtual Machine -
B
_//.f Choose Import Type
Before You Begin Choose the type of import to perform:
Locate Folder (® Register the virtual machine in-place (use the existing unique ID)
Select Virtual Machine () Restore the virtual machine (use the existing unique ID)
Choose Import Type () Copy the virtual machine (create a new unique ID)
Summary
< Previous | | Mext =

9. Select the radio button that corresponds to the appropriate type for your machine.

« Register the virtual machine in-place (use the existing unique ID)—Select this option if your
virtual machine files are saved on your virtual machine in the correct location.

« Restore the virtual machine (use the existing unique ID)—Select this option if your virtual

machine files are saved on a file share or removable drive and you want Hyper-V to move the
files to the correct location.

o Copy the virtual machine (create a new unique ID)—Select this option if you have a set of

virtual files you want to import multiple times (e.g., if you are using them as a template for new
virtual machines).

10. Select Next.
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Deploying the Virtual Engine on a Hyper-V Server

The Summary panel opens.

~#] Import Virtual Machine I

ﬁ Completing Import Wizard

Before You Begin ‘You are about to perform the following operation.
Locate Folder Description:
ESeclRiBAbGCRS Virtual Machine: nac_appliance_&4bit.5.2.0,189
Choose Import Type Import file: C:\MAC\nac_appliance_64bit.5, 2.0, 189_hypervinac_appliance_g4bit.5.2.0.
Configure Processor Import Type: Register (keep ID)
N Mumber of proce.ssors: 4 . . .
Metwork connection: Intel{R) PRO/1000 MT Network Connection - Virtual Switch
Connect Netwark Network connection:  Intel(R) PRO/1000 MT Network Connection - Virtual Switch

< m >

To complete the import and dose this wizard, dick Finish.

] (e

You are now ready to begin configuring the engine.

o If youare configuring an ExtremeCloud I1Q - Site Engine virtual engine, see ExtremeCloud IQ - Site
Engine Engine Configuration.

o Ifyou are configuring an ExtremeControl virtual engine, see ExtremeControl Engine Configuration.

o Ifyouare configuring on an ExtremeAnalytics virtual engine, see ExtremeAnalytics Engine
Configuration.
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Pre-Configuration Tasks

ExtremeCloud I1Q - Site Engine Engine
Configuration

After the ExtremeCloud IQ - Site Engine virtual engine has been deployed ona VMware ESX or
ESXiserver, ora Hyper-V server using the instructions in Engine Deployment, you are ready to
perform the initial engine configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your
initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in this
chapter:

« Engine hostname, IP address, and netmask

o Default Gateway IP address

« Name Server IP address and domain name

o NIS (Network Information Services) Server IP address (optional)

o Network Time Protocol (NTP) server IP address

ExtremeCloud IQ - Site Engine And ExtremeAnalytics
Licensing

If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an
ExtremeCloud IQ - Site Engine license. The ExtremeCloud 1Q - Site Engine
license also includes licensing for ExtremeAnalytics.

NOTES: o ExtremeCloud IQ - Site Engine is a subscription-based -only licensing model.

o ExtremeCloud IQ - Site Engine is not compatible with ExtremeCloud 1Q Connect level
account. Either the Pilot or Navigator level is mandatory.

You can view ExtremeCloud IQ and ExtremeCloud IQ - Site Engine license
information by accessing Administration > Licenses.

There are three tiers of licenses for ExtremeCloud |Q - Site Engine and devices:

o Pilot - Extreme devices

o Navigator - 3rd party devices
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ExtremeCloud |Q - Site Engine And ExtremeAnalytics Licensing

o No License - Status-Only devices

As you begin to onboard ExtremeCloud |Q - Site Engine and your devices, ExtremeCloud 1Q will
determine if you meet or exceed the license limits for each license type.

NOTE: Devices that do not have serial numbers or MAC addresses in Extreme Management
Center must be Rediscovered after you upgrade to ExtremeCloud 1Q - Site Engine
before they can be onboarded to ExtremeCloud 1Q.

For the first 90 days after ExtremeCloud IQ - Site Engine is released, license usage will
not be enforced for devices onboarded to ExtremeCloud 1Q. When ExtremeCloud 1Q
starts evaluating license usage, if your number of devices exceeds your licenses
available, ExtremeCloud 1Q - Site Engine transitions to a license violation state and
your access to ExtremeCloud IQ - Site Engine features and functionality is locked. To
resolve the license shortage you need to access the Extreme Networks portal or
ExtremeCloud IQ to evaluate the quantities of available Pilot and Navigator licenses
versus the number of licenses required by ExtremeCloud 1Q - Site Engine.

Licensing for Devices

When ExtremeCloud 1Q - Site Engine has been onboarded, it starts sending requests to add the
devices from its database to ExtremeCloud Q.

As devices are added and discovered in ExtremeCloud |1Q - Site Engine, they are onboarded to
ExtremeCloud |Q, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

Devices can be marked as Unmanaged in ExtremeCloud |Q, which means they are not using a
license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type Licenses Per
Device
Extreme-supported Device (Includes
VOSS/Fabric Engine, SLX, Extreme
Access, VDX, Fabric Manager, Unified
Switching VOSS/Fabric Engine, Unified Pilot :
Switching EXOS/Switch Engine, Summit
Series, ERS Series, 200 Series, 700 Series,
A Series, B Series, C Series, ICX Series,
Security Appliances, MLXe Series)
Chassis Pilot 1
ExtremeControlengine Pilot 1
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ExtremeCloud |Q - Site Engine And ExtremeAnalytics Licensing

ExtremeAnalyticsengine Pilot 1
ExtremeCloud IQ - Site Engine Pilot 1
Extreme Management Center Pilot 1
vSensor Pilot 1

All Other Devices (Includes Non-Extreme

Device) Navigator 1

Devices with Ping-Only profile No License 0

No License (These are not
Devices Added with No Access Profile onboarded to 0
ExtremeCloud IQ)

No License (These are not
Status-Only Devices onboarded to 0
ExtremeCloud 1Q)

For HiveOS APs, a Pilot license is required, but currently not enforced in ExtremeCloud 1Q - Site
NOTE: Engine Version 21.04.10. These are not onboarded to ExtremeCloud 1Q through ExtremeCloud 1Q -
Site Engine.

License Limits and Violations

Foreachrequest to add a device to ExtremeCloud 1Q - Site Engine, ExtremeCloud IQ
determines if there are enough licenses of that type available.

As a result, one of the following actions happens:

o Ifthere are enough licenses, device onboarding is successful.
o Ifthere are not enough Navigator licenses, a Pilot license is used instead.

o Ifthere are not enough Pilot licenses, the request is considered a license violation.

To correcta license limit violation, you must acquire more licenses (and, when the updated
license is sent to ExtremeCloud IQ, it is used by ExtremeCloud |1Q - Site Engine).

Devices Marked as Unmanaged

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also Unmanaged in
ExtremeCloud IQ - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the Network >
Site > Device table by a red X.
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Configuring the ExtremeCloud |Q - Site Engine Engine

For more details on the Network > Site > Device table, visit Onboarding Unmanaged Devices.

Related Information

Logging into ExtremeCloud 1Q - Site Engine

Configuring the ExtremeCloud IQ - Site Engine Engine

To configure the virtual engine to run the ExtremeCloud |Q - Site Engine applications:

In the Console tab of the vSphere client, login as root with no password, and then press [Enter].
The following screen displays.

xtrene MHetworks, Inc. ExtreneCloud 10 Site Engine Helcome to the Site Engine Setup

continue with
A yed in brackets.
L er) i - ring a new value will use the
iracketed value and proceed to the next item.

nnot be provided, the prompt will indic hat the item
or (Optional). The [en ey may b d without
ntering data for (Optiomal) items. A value must be entered for (Required) items,

fit the end of the setup process, the existing settings will be displayed
and opportunity will be provided to correct any errors.

'ress [enter] to begin setup or CTRL-C to exit:
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Configuring the ExtremeCloud |Q - Site Engine Engine

2. Press [Enter] to begin the setup.
The Root Password Configuration screen displays:

oot Password Conf lguration

The root password is currently set for thizs appliance.

o ld you like to set a root il.-l'-!'-!ullr‘l‘l Cysm) [yl?

Note: You must set a new root password. The root password will be used to access
the CLI of the ExtremeCloud IQ - Site Engine VM.

3. Press [Enter] to set a new root password. Enter the new password as prompted.

oot Password Conf iguration

The root password is currently set for this appliance.
ow 1d ] like to =&t a root ]l-.il.'-:u.".rd (yrm) [yl

Enter new UHIX pe
etype new UNIX

After you create the new root password, a screen displays where you can specify a user other than
root to run the ExtremeCloud IQ - Site Engine server, if desired. This user becomes the admin user for
the server. (Use the root user account when performing upgrades and accessing CLI).

! SETUET as

e Engine Server as the root user? (ysmnd [yl _

4. Entery touse the root user. Accept your selection.
Enter nto either use the "netsight” user or to specify a different user. Re-enter the password and
then accept your selection.
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Configuring the ExtremeCloud |Q - Site Engine Engine

the iiser Lo run the e

T (ysn) [yl m

lzer does nol exist, we need Lo creale |

r netsight:

In the Suite Network Configuration screen, enter the requested configuration information for each line

and press [Enter].
Enter the IP address of the name server. If you are using a name server, you must

enter a domain name for the engine (appliance). If you are using an NIS server to
authenticate users logging into the engine, make sure the NIS domain name is valid or
users will not be able to log in to the ExtremeCloud IQ - Site Engine applications.

ExtrentCloud [0 Gite Engine Hetwork Conf iguration
the hostname for the appliance (Bequired): x
the IF address for xi
the IF netmask [
- the gateway addr [
the IF addr of the name ver (Required):
~ the IF addr of an alternate name zerver (Optionall:
the domain name for xigse (Reguired): extrensnetuorks ., con
jo you want to use HIS (ysnd [ndT y
inter the [P addr of the HI TUER C

Enter the HIS domain name IZI':r'1|'||ir'r'4‘I.ZI: extremenetuworks

In the Confirm Network Settings screen, you can accept the current configuration or modify the
settings.

e enler wer Lthan a
I e C e, 14

extrenenstuar
snetworks .com

enter selection [81] 1
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Configuring the ExtremeCloud |Q - Site Engine Engine

7.

In the SNMP Configuration screen, enter the requested information for each line and press [Enter].

GHAF Conf igurat ion
he following information will be w
evice. The HF information ent
ith remote management applicatio
"lease enter the SHAP user name [Soapuser]:
"lease enter the SHAF authentication protocol A0S SHA [ADS]:
'lease enter the SHAP authentication credential [swapauthcred ]:

"lease enter the SHMAP privacy protocol DES or AES [DE

"lease enter the SMAF privacy credential [sompprivered]: _

In the SNMP Configuration summary screen, enter 0 to accept the settings.

sttings. To accept t and conplete

amy key other than th ect ion

wter the .||'|:L|r-||p1"i.1h- munber now or
ript at a later time.

ent sett ings

SR puUSer
Lion Protocol : HD

. SHHAP Pri E snappr lvered
. Modify all settings

inter selection [B]:

In the Configure Date and Time Settings screen, select whether you want to use an external Network
Time Protocol (NTP) server. Enter y to use NTP, and enter your NTP server IP address(es). Enter nto
configure the date and time manually and proceed to step 11.

Note that your NTP server should be using the same NTP settings as those configured
for your virtual engine (i.e., the same settings as the VMs that are hosted on the NTP
server).

mncnded that
iracy of time
omnunicat lons and Logige . Up to S5
cerver [P addre: : may be entered if HTP

Do you want to use NTF (gen) [yl?

Fleasze enter a HTP Server IF Address (Required): 192.168.1.200

ould you like to add another server (yesn) Ind?
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12.

In the NTP Servers validate selection screen, enter O to accept the current settings and proceed to
the Set Time Zone screen at step 13.

TF Servers

Th are the currently specified HTP se

Enter B of any key other than a valid zelection to coaplete NTF coof iguration and cont e,
enter the appropriate number from the

= and continue

Enter selection [0]:

If you answered no to using an NTP server to set date and time, set the date and time in the Set Date
and Time screen.

et Date fimd Time
Fri 141 Hay
il time as directed wh input is

Lhe fol low ing format :

» digit month of year
igi of month

it - uging a 24 hour clock

digit e hour
? digit =zec

enter the month [05]):

enter the day of the month [14]):

enter the year [20211:

se enter the hour of day [131:
e enter the minutes [94):

"lease enter the seconds [04]:

»t to wse UTC. Specifying no for using UTC,
& hardware clock using localtime.

Do you want to use UTC (ysm) [nl7

23 0f 59



Launching ExtremeCloud |Q - Site Engine

13. Inthe Set Time Zone screen, type the number that corresponds to the appropriate time zone and
press [Enter].

set Time Zone

ysten.
in the srsshar fo directory.

t - Lhtk
3. [ther Showus a graphical

Ente ection [1]:

In the Modify Settings screen, you can accept the current configuration or modify the settings.

od ify Settings
All of the information v . ~te the installation of the

10 Site i 8 . & =d . Enter € aniy key other than
wal id - to © ! i - =, enter the

work settings

. Hodify all settings

+ selection [8] i

The ExtremeCloud IQ - Site Engine application software is automatically installed. This could
take a few minutes. When you see the following screen, configuration is complete.

Extrene MHetworks, . ExtreneCloud I - Site Engine - 3 p Complete

lowd 10 Site Engi i =te > appliance is
) Lo @ t
located in the

Note: After you have completed the configuration, it is important to take a snapshot of your
engine configuration to be used in the event an engine image recovery is required. For
instructions on how to take a snapshot, see your vSphere client documentation.

Launching ExtremeCloud IQ - Site Engine

Now that you have configured the ExtremeCloud |Q - Site Engine virtual engine, you are ready
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to access ExtremeCloud 1Q - Site Engine from a remote client machine.

Open a browser window on the remote client machine and enter the ExtremeCloud |1Q - Site
Engine Launch page URL in the following format:

https://<servername>:8443/

where <servername>is the ExtremeCloud |Q - Site Engine virtual engine IP address or hostname,

and 8080 is the required port number. For example,
https://10.20.30.40:8443/

ExtremeCloud |Q - Site Engine login page opens.

Log inas root with the same password you defined in step 3 or as the user you specified in step
4,

This is because the ExtremeCloud |1Q - Site Engine Server has a single pre-defined user, which is
the user who performed the ExtremeCloud |Q - Site Engine installation. After the initial user has
logged in, additional users (with usernames valid for Ubuntu) can log in.

Onboarding ExtremeCloud IQ - Site Engine

To access ExtremeCloud |Q - Site Engine, you must first complete the steps to onboard
ExtremeCloud |Q - Site Engine to ExtremeCloud Q.

There are two scenarios by which you can onboard ExtremeCloud IQ - Site Engine:

« After Upgrading to ExtremeCloud 1Q - Site Engine from Extreme Management Center Versions
8.4.4 or 85.5.

o After Initial Installation of ExtremeCloud |Q - Site Engine

After Upgrading to ExtremeCloud IQ - Site Engine from Extreme

Management Center Versions 8.4.4 or 8.5.5
When you upgrade from Extreme Management Center to ExtremeCloud |Q - Site Engine, if you
used the softlaunch feature of Extreme Management Center in ExtremeCloud I1Q, you need to

remove Extreme Management Center from ExtremeCloud I1Q before onboarding ExtremeCloud
IQ - Site Engine.

After you upgrade your Extreme Management Center to ExtremeCloud 1Q - Site Engine, you
need to onboard ExtremeCloud 1Q - Site Engine:

1. Loginto ExtremeCloud IQ - Site Engine. Enter your ExtremeCloud IQ - Site Engine username and
password. Select Login.
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ExtrerneCloud 1G She Engine

2. Accept the License Agreement.

Welcome to ExtremeCloud IQ - Site Engine

License Agreement

PLEASE READ ALL OF THE FOLLOWING TERMS AND CONDITIONS OF THIS END USER LICENSE AGREEMENT.

This End User License Agreement ("Agreement’) is a legal agreement between You andior the entity You represent
and Extreme Metworks, Inc., on behalf of itself and its affiiates, including, but not limited to, Extreme Netwerk Ireland
Ops Limited (collectively, "Extreme”) for the Software (defined below) licensed by Extreme or its licensors.

By downloading, installing, copying, accessing, or using the Software, or aclivating a Software license key, or by
clicking an "I Agree” or similar button, or by opening the Software media, You agree to the terms and conditions of this
Agreement as a condition of Your use of, and right to use, the Software.

If You do not agree to all the terms and conditions in this Agreement, do not download, install or use the Software. If the
Software was delivered to You embedded in an Extreme Hardware Product, do not install or use that Extreme
Hardware Product.

Extreme may make changes to this Agreement at any time and will provide written notice of such changes to You and
give You an opportunity to accept those changes. Your continued use of the Software after such changes have been
posted will signify your assent to acceptance of the revised terms.

If You and Exireme have signed a separate written agreement covering Your rights and duties with respect to the
Software, then that written agreement take precedence over any conflicting terms in this Agreement.

Your privacy is important to Extreme. Extreme’s Privacy Policy is located at

https: e extremenetworks com/company/flegaliprivacy/. Please read our Privacy Policy for information related to
Extreme's collection, use and disclosure of Your personal information. By agreeing to the terms of this Agreement, You
are also accepting the terms of Extreme's Privacy Policy.

4 DEEIKITIANS Conitalizad tarme nead in thic Anracmant ara dofined in Sactinn 18 halow

| accept the License Agreement

Select Next.

3. Toonboard ExtremeCloud 1Q - Site Engine to ExtremeCloud I1Q, provide your ExtremeCloud IQ email
address and password.

26 of 59



Onboarding ExtremeCloud |Q - Site Engine

Welcome to ExtremeCloud 1Q - Site Engine

Back Onboard to ExtremeCloud 1Q

Please enter your ExtremeCloud IQ credentials to onboard the ExtremeCloud IQ - Site Engine.

Email
Password

Don't have an account? Register here

Advanced

After ExtremeCloud IQ - Site Engine has successfully onboarded, you can now access
ExtremeCloud IQ - Site Engine.

If your environment requires HTTP Proxy or other advanced settings, select the Advanced link.
If you do not have an ExtremeCloud |Q account, select the Register Here link.

After Initial Installation of ExtremeCloud IQ - Site Engine

Complete the following steps to onboard ExtremeCloud 1Q - Site Engine after you install
ExtremeCloud |Q - Site Engine:
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1. Accept the ExtremeCloud 1Q - Site Engine License Agreement.

Welcome to ExtremeCloud IQ - Site Engine

License Agreement

PLEASE READ ALL OF THE FOLLOWING TERMS AND CONDITIONS OF THIS END USER LICENSE AGREEMENT.

This End User License Agreement ("Agreement”) is a legal agreement between You and/or the entity You represent
and Extreme Networks, Inc., on behalf of itself and its affiliates, including, but not limited to, Extreme Netwaork Ireland
Ops Limited (collectively, "Extreme”) for the Software (defined below) licensed by Extreme or its licensors

By downloading, installing, copying, accessing, or using the Software, or acfivating a Software license key, or by
clicking an "l Agree” or similar button, or by opening the Software media, You agree to the terms and conditions of this
Agreement as a condition of Your use of, and right to use, the Software.

If You do not agree to all the terms and conditions in this Agreement, do not download, install or use the Software. If the
Software was delivered to You embedded in an Extreme Hardware Product, do not install or use that Extireme
Hardware Product

Extreme may make changes to this Agreement at any time and will provide written notice of such changes to You and
give You an opportunity to accept those changes. Your continued use of the Software after such changes have been
posted will signify your assent to acceptance of the revised terms

If You and Extreme have signed a separate written agreement covering Your rights and duties with respect to the
Software, then that written agreement take precedence over any conflicting terms in this Agreement.

Your privacy is imporiant to Exireme. Extreme's Privacy Policy is located at
https:/forww.extremenetworks.com/company/legaliprivacy/. Please read our Privacy Policy for information related to
Extreme's collection, use and disclosure of Your personal information. By agreeing to the terms of this Agreement, You
are also accepting the terms of Extreme's Privacy Policy.

| accept the License Agreement

2. Enter your ExtremeCloud 1Q email address and password. Select Login.

Welcome to ExtremeCloud 1Q - Site Engine

Back Onboard to ExtremeCloud 1Q

Please enter your ExtremeCloud IQ credentials te onboard the ExtremeCloud IQ - Site Engine.

Email
Password

Don't have an account? Register here

Advanced

If your environment requires HTTP Proxy or other advanced settings, select the
Advanced link. If you do not have an ExtremeCloud IQ account, select the Register Here
link.

3. ExtremeCloud IQ retrieves the license information and sends it to ExtremeCloud IQ - Site Engine.
ExtremeCloud 1Q - Site Engine is onboarded to ExtremeCloud 1Q.

You can now access the ExtremeCloud |Q - Site Engine login page.
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ExtremeCloud I1G Site Engine

Enter the Username and Password you specified during the ExtremeCloud |Q - Site
Engine installation.

Onboarding Devices

When ExtremeCloud |Q - Site Engine has been onboarded, it can start sending requests to add
the devices from its database to ExtremeCloud IQ.

NOTES: Devices with IPv6 addresses in ExtremeCloud 1Q - Site Engine will not be onboarded
as locally-managed devices in ExtremeCloud IQ. Only devices with IPv4 addresses
qualify.

As devices are added and discovered in ExtremeCloud 1Q - Site Engine, they are onboarded to
ExtremeCloud IQ, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

View the ExtremeCloud |1Q - Site Engine and ExtremeCloud |1Q Onboarding Flowchart for a
detailed chart on how devices are onboarded to ExtremeCloud IQ and managed by
ExtremeCloud IQ - Site Engine.

X1Q Onboarded Status for Devices

After an attemptis made to onboard a device, the XIQ Onboarded column of the Network > Site
> Device table indicates the status of the onboarding attempt.
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Black check mark - Indicates that the device is onboarded to ExtremeCloud 1Q.

Red X - Indicates the device is onboarded but Unmanaged, which means it is not using a license, it has
read-only device-level support, and available features in ExtremeCloud |1Q - Site Engine are limited.
Other functionality, including Status Polling, Historical Device + Port Statistics Collection, Existing
Scheduled Tasks, and Archives, are supported for devices with Unmanaged status, but these devices
cannot be configured for new tasks or new archives.

NOTES: InExtremeCloud IQ - Site Engine version 22.3.10, only use ExtremeCloud 1Q to
set an ExtremeCloud IQ - Site Engine onboarded device to Unmanaged as a
temporary measure while you obtain more licenses.

If you mark a device as Unmanaged so it does not trigger a license limit
violation, you can then access ExtremeCloud 1Q - Site Engine and delete the
device before the license violation occurs.

You can perform an enforce for an ExtremeControl engine with an Unmanaged
status; however, if the device has an Unmanaged status, then the enforce does
not reconfigure the device and changes are not written to the device.

When devices are marked as Unmanaged in ExtremeCloud I1Q, they are also Unmanaged in
ExtremeCloud IQ - Site Engine.

In addition, existing ExtremeAnalytics functionality for devices with an Unmanaged status
is still supported, but only with existing configuration.

Blank - Indicates the device is not successfully onboarded to ExtremeCloud IQ from the ExtremeCloud
IQ - Site Engine because either it is already onboarded to ExtremeCloud 1Q (either from another
ExtremeCloud 1Q - Site Engine or by using the IQ Agent to connect directly), or because
ExtremeCloud 1Q - Site Engine lost its connection to ExtremeCloud 1Q.
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NOTE: If a device's status is Blank, it has limited features available in ExtremeCloud IQ - Site
Engine because management of the device is owned by ExtremeCloud 1Q.

o N/A - Indicates the device is not eligible to be onboarded to ExtremeCloud I1Q because it does not
have a valid serial number or MAC address, or Extreme does not yet offer onboarding support for the
device.

NOTE: If ExtremeCloud IQ - Site Engine does not recognize a device’s serial number or
MAC address, right-click on the device and select Rediscover to attempt to
discover the device’s serial number or MAC address. After the device's serial
number or MAC address is discovered, it can be onboarded to ExtremeCloud
IQ during the next onboarding cycle.

Restoring a Database from a Windows Server to the
Engine

This section describes several ExtremeCloud 1Q - Site Engine configuration changes that are
required if you are moving your installation from a Windows platform system to the
ExtremeCloud IQ - Site Engine virtual engine. Perform these steps after restoring your database
to the new engine. (For information on restoring a database, see the Server Information section
in the ExtremeCloud |Q - Site Engine Suite-Wide Tools User Guide.)

Changing Console

Use the following instructions to change the location of syslog and trap information to the new
location on the engine.

Changing Syslog Location

Change the Syslog Log Manager to point to the new location on the engine. This will enable the
display of syslog information in the Syslog Event View tab.

1. From the Console menu bar, select Alarm/Event > Tools > Event View Manager.

2. Select on the Syslog entry under Available Log Managers, and select the Edit button.
The Log Manager Parameters window opens.

3. Change the pathin the Log Directory field to /var/log/messages.
4. Change the Pattern to Red Hat LINUX Syslog Pattern.
5. Select OK.

Changing Traps Location

Change the Traps Log Manager to point to the new location on the engine. This will enable the
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display of trap information in the Traps Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Traps entry under Available Log Managers, and select the Edit button.
The Log Manager Parameters window opens.

3. Change the path in the Log Directory field to %logdir%/traps.
4. Select OK.

Changing Inventory Settings

If you are using Inventory Settings in ExtremeCloud |Q - Site Engine, you must change the Data
Storage Directory path to point to the new location on the engine. The Data Storage Directory is
where all Inventory data is stored, including capacity planning reports, configuration templates,
archived configurations, and property files.

1. Select Administration > Options.
2. Expand the Inventory Manager options folder and select Directory Path in the Data Storage section.

3. Change the path to the correct new location.
On a default installation, the path would be :/usr/local/Extreme_
Networks/NetSight/appdata/InventoryMgr/

4. Select OK.

Changing ExtremeCloud IQ - Site Engine Engine Settings

Use these steps if you need to change your ExtremeCloud 1Q - Site Engine virtual engine
settings following your initial engine configuration. Perform these steps in the vSphere client
Console tab orlogin using an ssh session to ExtremeCloud 1Q - Site Engine CLI..

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP address, enter

the following command at the login prompt in the Console tab:
/usr/postinstall/dnetconfig

This will start the network configuration script and enable you to make the required changes.
You mustreboot the engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as system contact, system location, Trap Server,
SNMP Trap Community String, SNMP User, SNMP Authentication,and SNMP Privacy

credentials, enter the following command at the login prompt in the Console tab:
/usr/postinstall/snmpconfig

This will start the SNMP configuration script and enable you to make the required changes.
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Changing Date and Time Settings

To enable ordisable NTP for engine date and time, or to manually set the date and time on the

engine, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the settings.

Upgrading ExtremeCloud IQ - Site Engine Engine
Software

Upgrades to the ExtremeCloud |1Q - Site Engine engine software are available on the
ExtremeCloud IQ - Site Engine web page.

Prior to performing an upgrade, you can create a snapshot of the engine that you can revert to
in the event an upgrade fails. Refer to the vSphere client documentation for instructions on
creating a snapshot.

1. Ona system with an internet connection, go to the ExtremeCloud IQ - Site Engine web page:
http://extranet.extremenetworks.com/downloads/pages/NMS.aspx.

2. Enter your email address and password.
You will be on the ExtremeCloud IQ - Site Engine page.

Select the Software tab and select a version of ExtremeCloud IQ - Site Engine.

4. Download the ExtremeCloud IQ - Site Engine virtual engine image from the ExtremeCloud 1Q - Site
Engine Virtual Appliance (engine) section.

5. Use FTP, SCP, or a shared mount point, to copy the file to the ExtremeCloud IQ - Site Engine virtual
engine.

6. SSH tothe engine.
7. Cdtothe directory where you downloaded the upgrade file.

8. Change the permissions on the upgrade file by entering the following command:
chmod + x ./ExtremeCloudIQSiteEngine <version> 64bit install.bin

9. Runtheinstall program by entering the following command:
./ExtremeCloudIQSiteEngine <version> 64bit install.bin

The upgrade automatically begins.

The ExtremeCloud |Q - Site Engine Server are restarted automatically when the upgrade is
complete. Because your ExtremeCloud I1Q - Site Engine engine settings were migrated, you are
not required to perform any configuration on the engine following the upgrade.
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Reinstalling ExtremeCloud 1Q - Site Engine  Appliance Software

Reinstalling ExtremeCloud IQ - Site Engine Appliance
Software

In the event that a software reinstall becomes necessary, restore an engine snapshot that you
previously made using the vSphere client. Refer to the vSphere client documentation for
instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you must re-deploy and reconfigure the
ExtremeCloud 1Q - Site Engine virtual engine following the instructions in Engine Deployment
and this chapter.

Note: Be aware that a reinstall procedure reformats the hard drive, reinstalls all the
ExtremeCloud IQ - Site Engine engine software, the operating system, and all related Linux
packages. We recommend backing up your hard drive before reinstalling.
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ExtremeControl Engine Configuration

After the ExtremeControl virtual engine has been deployed ona VMware ESX or ESXiserver, or
a Hyper-V server using the instructions in Engine Deployment, you are ready to perform the
initial engine configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your
initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in this
chapter:

o Engine Hostname, IP address, and netmask

o Default Gateway IP address

o ExtremeCloud IQ - Site Engine Server IP address
« Name Server IP address and domain name

o Network Time Protocol (NTP) server IP address

Licensing for ExtremeControl

The licensing details for ExtremeControl vary depending on whether
ExtremeCloud IQ - Site Engine is onboarded after upgrading from Extreme
Management Center or if it is initially installed.

After Upgrading From Extreme Management Center versions 8.4.4 or 8.5.5

If you are upgrading from Extreme Management Center versions 8.4.4 or 8.5.5 to ExtremeCloud
|Q - Site Engine version 22.3.10, the licensing and capabilities of ExtremeControl does not
change. The following are included in the licenses:

e NMS-ADV License includes 500 Access Control End-Systems and 50 Guest and loT Manager
(GIM) licenses.

e NMS-xx License includes 250 Access Control End-Systems and 25 GIM licenses.

If you had an NMS-xx License with Extreme Management Center, you can upgrade to an NMS-
ADV License on the Extreme Portal after you onboard ExtremeCloud 1Q - Site Engine.

NOTE: Air gapped mode (where ExtremeCloud |Q - Site Engine is not connected to
ExtremeCloud IQ) is not supported for ExtremeCloud IQ - Site Engine version
21.04.10.
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Upon Initial Installation

If you are completing aninitial install of ExtremeCloud IQ - Site Engine, there is no end-system
license included. The evaluation license can be generated on the Extreme Portal which includes
unlimited end-systems and Guest and loT Manager (GIM) licenses.

Configuring the ExtremeControl Engine

To configure the virtual engine to run the ExtremeControl software:

1.

In the Console tab of the vSphere client, login as root with no password and press [Enter].

The following screens display:

Welcome to Extreme Networks Access Control Engine 21.4.10.xx
controlengine login: root

Extreme Networks Access Control Engine 21.4.10.xx Configuration

Press CTRL-C to skip configuration for now

Please enter the information as it is requested to continue with the configuration.
Typically a default value is displayed in brackets. Pressing the [enter] key without
entering a new value will use the bracketed value and proceed to the next item.

If a default value cannot be provided, the prompt will indicate that the item is either
(Required) or (Optional). The [enter] key may be pressed without entering data for
(Optional) items. A value must be entered for (Required) items.

At the end of the setup process, the existing settings will be displayed and
opportunity will be provided to correct any errors.

Press [enter] to begin setup or CTRL-C to exit:

Press [Enter] to begin the setup.
The Root Password Configuration screen displays:

There is currently no password set in the system administrator account (root). It is
recommended that you set one that is active the first time the machine is rebooted.

Would you like to set a root password (y/n) [y]1?
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3. Press [Enter] toset a new root password. Enter the new password as prompted.
Enter new UNIX password:
Retype new UNIX password:
Password updated successfully.

4. Inthe ExtremeControl engine Configuration screen, enter the requested configuration information for
eachline and press [Enter].

Enter the hostname for the appliance [nhacappliancel:
Enter the IP address for <hostname> (Required):
Enter the IP netmask [255.255.255.0]:

Enter the gateway address [192.168.2.1]:

Enter the IP address of the name server (Optional):
Enter the domain name for <hostname> (Optional):
Enter the IP address of the Server (Required):

5. Inthe SNMP Configuration screen, enter the requested information for each line and press [Enter].

The following information will be used to configure SNMP management of this device.
The SNMP information entered here must be used to contact this device with remote
management applications such as ExtremeCloud IQ - Site Engine Console.

Please enter the SNMP user name [snmpuser]:

Please enter the SNMP authentication protocol - MD5 or SHA [MD5]:
Please enter the SNMP authentication credential [snmpauthcred]:
Please enter the SNMP privacy protocol - DES or AES [DES]:

Please enter the SNMP privacy credential [snmpprivcred]:

6. Inthe Configure Date and Time Settings screen, select whether you want to use an external Network
Time Protocol (NTP) server. Enter y to use NTP, and enter your NTP server IP address(es). Enter nto
configure the date and time manually and proceed to step 8.

The appliance date and time can be set manually or using an external Network Time
Protocol (NTP) server. It is strongly recommended that NTP is used to configure the
date and time to ensure accuracy of time values for SNMP communications and
logged events. Up to 5 server IP addresses may be entered if NTP is used.

Do you want to use NTP (y/n) [y1? y

Please enter a NTP Server IP Address (Required): 144.131.10.120
Would you like to add another server (y/n) [n]? y

Please enter a NTP Server IP Address (Required): 144.131.10.121
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Would you like to add another server (y/n) [n]? n

In the NTP Servers validate selection screen, enter O to accept the current settings and proceed to
the Set Time Zone screen at step 10.

These are the currently specified NTP servers. Enter O or any key other than a valid
selection to complete NTP configuration and continue. If you need to make a change,
enter the appropriate number from the choices listed below.

144.131.10.120

144.131.10.121

0. Accept the current settings

1. Restart NTP server selection

2. Set date and time manually

Enter selection [0]: O

If you answered no to using an NTP server to set date and time, set the date and time in the Set Date
and Time screen.

The current system date and time is: Thu Apr 24 09:34:08 2018

Please enter the values for date and time as directed where input is expected in the
following format:

MM - 2 digit month of year

DD - 2 digit day of month

YYYY - 4 digit year

hh - 2 digit hour of day using a 24 hour clock mm - 2 digit minute of hour

ss - 2 digit seconds

Please enter the month [04]:

Please enter the day of the month [24]:
Please enter the year [2018]:

Please enter the hour of day [09]:
Please enter the minutes [341]:

Please enter the seconds [34]:

In the Use UTC screen, select whether you want the system clock to be set to use UTC.

The system clock can be set to use UTC. Specifying no for using UTC,
sets the hardware clock using local time.

Do you want to use UTC (y/n) [n]?
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10. Inthe Set Time Zone screen, select the appropriate time zone and press [Enter].

You will now be asked to enter the time zone information for this system.
Available time zones are stored in files in the /usr/share/zoneinfo directory.
Please select from one of the following example time zones:

1. US Eastern

2. US Central

3. US Mountain

4. US Pacific

5. Other - Shows a graphical list

Enter selection [1]:

1. In the Current Appliance Configuration screen, review the current settings and press [Enter] to
continue.

Access Control Engine Configuration:

Host Info: <hostname>/<IP address>/<netmask>

Gateway/Name Server/Domain: <gateway>/<dns server>/<domain>
SNMP User: snmpuser

SNMP Authentication Protocol: snmpauthcred

SNMP Authentication: snmpprivcred

SNMP Privacy Protocol:

SNMP Privacy:

ExtremeCloud IQ - Site Engine Server IP: <ECC server ip>

Press [enter] to continue:

In the Appliance Network Configuration Complete screen, you can accept the current
configuration or modify the settings.

Configuration of the appliance network settings is now complete. Enter O or any key other
than a valid selection to continue. If you need to make a change, enter the appropriate
number from the choices listed below.

0. Accept the current settings
1. Edit NAC Appliance settings
2. Edit SNMP settings
3. Edit date and time
4. Modify all settings

Enter selection [O]:

When you see the following screen, configuration is complete.
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Extreme Networks - ExtremeControl Appliance - Setup Complete

Setup of the NAC Appliance is now complete. Details of the appliance setup process are
located in the log files in the /var/log/install directory.

Note: After you have completed the configuration, it is important to take a snapshot of your
engine configuration to be used in the event an engine image reinstall is required. For
instructions on how to take a snapshot, see your vSphere client documentation.

You are now ready to use ExtremeCloud 1Q - Site Engine to manage your ExtremeControl. If this
is your initial commissioning of the engine, you can launch ExtremeCloud |Q - Site Engine and
select Getting Started from the Help menu for information on using ExtremeCloud 1Q - Site
Engine to configure and manage your ExtremeControl.

If you have reinstalled your ExtremeControl software, use ExtremeCloud IQ - Site Engine to
enforce the engine. Enforcing writes your ExtremeCloud 1Q - Site Engine configuration
information to the engine.

Note:

When you add the virtual engine to ExtremeCloud |Q - Site Engine, you will be asked to supply a
virtual ExtremeControl engine license number. (When you purchased your engine, you received
a Licensed Product Entitlement ID. This Entitlement ID allows you to generate a product license.
Refer to the instructions included with the Entitlement ID that was sent to you.)

Unlicensed virtual ExtremeControl engines will appear with an orange arrow iconin
ExtremeCloud IQ - Site Engine, and cannot be enforced. You can view the engine license status
in the Administration > Diagnostics > Server > Server Licenses tab in ExtremeCloud IQ - Site
Engine.

Changing ExtremeControl Engine Settings

This section provides instructions for changing your ExtremeControl engine settings following
your initial engine configuration, should the need arise. Depending on the settings you want to
change, you can use either the Control > Access Control tab of ExtremeCloud |Q - Site Engine or
the vSphere client Console tab to make the changes.

Using the Access Control tab

Use the Access Control tab to easily change Engine Settings including DNS, NTP, SSH, and
SNMP configuration. You can also use the Access Control tab to change the engine hostname
and default gateway, as well as configure static routes for advanced routing configuration.

Changing DNS, NTP, SSH, and SNMP Settings

Use the Engine Settings tab to change the following:
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o DNS Configuration — Search domains and DNS servers
o NTP Configuration — Time zone and NTP servers
o SSH Configuration — Port number and authentication

o SNMP Configuration — SNMP credentials for the engine
To access the Engine Settings tab:

1. Open the Control > Access Control tab.

In the left-panel tree, expand the Configuration folder.

In the Configuration folder, expand the Global & Engine Settings folder.
In the Global & Engine Settings folder, expand the Engine Settings folder.

Select the desired engine (typically Default unless you have configured a custom engine setting).

I

In the right panel, select the Network Settings tab.

Changing Hostname, Gateway, and Static Routes

On the Control > Access Control tab, use the Interfaces window for an engine to change the
engine hostname, default gateway, and static routes.

1. Expand the Engines folder in the left-panel tree.
2. Select the ExtremeControl engine

3. Select the right-panel Details tab.
4

In the Interface Summary section, select Edit to open the Interfaces window where you can change
the engine hostname and default gateway.

S

Select Save.

6. Inthe Interface Summary section, select Static Routes to open the Static Route Configuration window
where you can add or edit the static routes used for advanced routing configuration.

Using the vSphere Client Console Tab

Use the vSphere client Console tab to change the engine IP address, ExtremeCloud |Q - Site
Engine server IP address, and web service credentials. If desired, you can also use the Console
tab to change basic network settings such as engine hostname, SNMP configuration, and date
and time settings, although you should use NAC Manager to make these changes, if possible
(see Using the Access Control tab).

Changing the ExtremeCloud 1Q - Site Engine Server IP Address

To change the IP address of the ExtremeCloud |Q - Site Engine server, enter the following

command at the login prompt in the Console tab:
/opt/nac/configMgmtIP <IP address>

Enter the following command to start using the new ExtremeCloud 1Q - Site Engine server:
nacctl restart
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Changing Web Service Credentials

The Web Service credentials provide access to the ExtremeControl engine Administration web
page and the web services interface for the ExtremeControl engine. Engines are shipped with a
preconfigured default password.

If you have changed the credentials on the Access Control tab (in the Engine Settings window)
and theninstall a new engine that uses the default password, you will not be able to monitor or
enforce to the new engine until you change the password on the engine using the command
below. The credentials you enter on the engine must match the credentials specified on the
Access Control tab in the Engine Settings window.

To change Web Service credentials, enter the following command at the login prompt in the
Console tab:

/opt/nac/configWebCredentials <username> <password>

Enter the following command to restart the engine:

nacctl restart

Changing the Engine IP Address and Basic Network Settings

To change the engine IP address, as well as basic network settings such as hostname and SNMP
configuration (including system contact, system location, trap server, SNMP trap community
string, SNMP user, SNMP authentication, and SNMP privacy credentials), enter the following

command at the login prompt in the Console tab:
/usr/postinstall/nacconfig

This will start the network configuration script and enable you to make the desired changes.

Changing Date and Time Settings

To enable ordisable NTP for engine date and time, or to manually set the date and time on the

engine, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the settings.

Upgrading ExtremeControl Engine Software

Instructions for performing the software upgrade are available here.

Prior to performing an upgrade, you can create a snapshot of the engine that you can revert to
in the event an upgrade fails. Refer to the vSphere client documentation for instructions on
creating a snapshot.

Reinstalling ExtremeControl Engine Software

In the event that a software reinstall becomes necessary, restore an engine snapshot that you
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Reinstalling ExtremeControl Engine Software

previously made using the vSphere client. Refer to the vSphere client documentation for
instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you must re-deploy and reconfigure the
ExtremeControl virtual engine following the instructions in Engine Deployment and this chapter.

Note: Be aware that a reinstall procedure reformats the hard drive, reinstalls all the
ExtremeControl engine software, the operating system, and all related Linux packages.
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ExtremeAnalytics Engine Configuration

After the ExtremeAnalytics virtual engine has been deployed ona VMware ESX or ESXi server,
or a Hyper-V server using the instructions in Engine Deployment, you are ready to perform the
initial engine configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following your
initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in this
chapter:

o Engine hostname, IP address, and netmask

o Default Gateway IP address

« Name Server IP address and domain name

o NIS (Network Information Services) Server IP address (optional)

o Network Time Protocol (NTP) server IP address

ExtremeCloud IQ - Site Engine And ExtremeAnalytics
Licensing

If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an
ExtremeCloud IQ - Site Engine license. The ExtremeCloud IQ - Site Engine
license also includes licensing for ExtremeAnalytics.

NOTES: o ExtremeCloud IQ - Site Engine is a subscription-based -only licensing model.

o ExtremeCloud IQ - Site Engine is not compatible with ExtremeCloud IQ Connect level
account. Either the Pilot or Navigator level is mandatory.

You can view ExtremeCloud 1Q and ExtremeCloud IQ - Site Engine license
information by accessing Administration > Licenses.

There are three tiers of licenses for ExtremeCloud 1Q - Site Engine and devices:

o Pilot - Extreme devices
« Navigator - 3rd party devices

e No License - Status-Only devices
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As you begin to onboard ExtremeCloud |Q - Site Engine and your devices, ExtremeCloud 1Q will
determine if you meet or exceed the license limits for each license type.

NOTE: Devices that do not have serial numbers or MAC addresses in Extreme Management
Center must be Rediscovered after you upgrade to ExtremeCloud 1Q - Site Engine
before they can be onboarded to ExtremeCloud 1Q.

For the first 90 days after ExtremeCloud IQ - Site Engine is released, license usage will
not be enforced for devices onboarded to ExtremeCloud 1Q. When ExtremeCloud 1Q
starts evaluating license usage, if your number of devices exceeds your licenses
available, ExtremeCloud 1Q - Site Engine transitions to a license violation state and
your access to ExtremeCloud IQ - Site Engine features and functionality is locked. To
resolve the license shortage you need to access the Extreme Networks portal or
ExtremeCloud IQ to evaluate the quantities of available Pilot and Navigator licenses
versus the number of licenses required by ExtremeCloud 1Q - Site Engine.

Licensing for Devices

When ExtremeCloud 1Q - Site Engine has been onboarded, it starts sending requests to add the
devices from its database to ExtremeCloud Q.

As devices are added and discovered in ExtremeCloud |1Q - Site Engine, they are onboarded to
ExtremeCloud |Q, with a request for a license of the appropriate tier (Navigator, Pilot or No
License) that each device will require.

Devices can be marked as Unmanaged in ExtremeCloud |Q, which means they are not using a
license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type Licenses Per
Device

Extreme-supported Device (Includes
VOSS/Fabric Engine, SLX, Extreme
Access, VDX, Fabric Manager, Unified
Switching VOSS/Fabric Engine, Unified Pilot :
Switching EXOS/Switch Engine, Summit
Series, ERS Series, 200 Series, 700 Series,
A Series, B Series, C Series, ICX Series,
Security Appliances, MLXe Series)
Chassis Pilot 1
ExtremeControlengine Pilot 1
ExtremeAnalyticsengine Pilot 1
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ExtremeCloud IQ - Site Engine Pilot 1
Extreme Management Center Pilot 1
vSensor Pilot 1

All Other Devices (Includes Non-Extreme

Device) Navigator 1

Devices with Ping-Only profile No License 0

No License (These are not
Devices Added with No Access Profile onboarded to 0
ExtremeCloud 1Q)

No License (These are not
Status-Only Devices onboarded to 0
ExtremeCloud IQ)

For HiveOS APs, a Pilot license is required, but currently not enforced in ExtremeCloud 1Q - Site
NOTE: Engine Version 21.04.10. These are not onboarded to ExtremeCloud 1Q through ExtremeCloud 1Q -
Site Engine.

License Limits and Violations

Foreachrequestto add a device to ExtremeCloud 1Q - Site Engine, ExtremeCloud IQ
determines if there are enough licenses of that type available.

As a result, one of the following actions happens:

o Ifthere are enough licenses, device onboarding is successful.
o Ifthere are not enough Navigator licenses, a Pilot license is used instead.

o Ifthere are not enough Pilot licenses, the request is considered a license violation.

To correct a license limit violation, you must acquire more licenses (and, when the updated
license is sent to ExtremeCloud 1Q, it is used by ExtremeCloud 1Q - Site Engine).

Devices Marked as Unmanaged

When devices are marked as Unmanaged in ExtremeCloud 1Q, they are also Unmanaged in
ExtremeCloud |Q - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the Network >
Site > Device table by a red X.
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For more details on the Network > Site > Device table, visit Onboarding Unmanaged Devices.

Related Information

Logging into ExtremeCloud IQ - Site Engine

Configuring the ExtremeAnalytics Engine

To configure the virtual engine to run the ExtremeAnalytics application:

1. Inthe Console tab of the vSphere client, login as root with no password, and then press [Enter].
The following screen displays.
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2. Press [Enter] to begin the setup.
The Root Password Configuration screen displays:
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2. Interface Mirrored

Separate interfaces are configured for management and monitoring
traffic.

The monitoring interface will put into tap mode for traffic
monitoring.

Suitable for feeds from XO0S/VOSS/SLX switches.

3. Interface Tunnel Mirrored

Separate interfaces are configured for management and monitoring
traffic.

The monitoring interface will get its own IP Address and GRE Tunnels
will be configured for traffic monitoring.

Suitable for feeds from Coreflow switches.

4. Manual Mode
The interface and tunneling configurations will not be modified by
this script, leaving them to be manually edited by the user instead.

Please select a deployment mode [2]:

Note: If you select deployment mode 4, refer to the ExtremeAnalytics Deployment
Guide for information on how to configure your deployment manually.

If you selected deployment mode 1, 2, or 3, the Appliance (Engine) Network Configuration for ethO
screen displays. For each line, enter the requested configuration information and press [Enter].

If you will be using DNS, the IP address of the name server should be provided. If you
are using a name server then you must enter a domain name for the engine. The NIS
server is used to authenticate users logging into the engine. If you are using an NIS
server, make sure the NIS domain name is valid or users might not be able to log in to
the ExtremeCloud IQ - Site Engine applications.

ExtremeAnalytics Appliance Network Configuration for ethO

Enter information below to configure ethO

Enter the hostname for the appliance (Required):

Enter the IP address for ethO on 10.54.56.141 [10.54.56.141]:
Enter the IP netmask [255.255.255.0]:

Enter the gateway address [10.54.56.2]:

Enter the IP address of the name server (Optional):

Enter the domain name for 10.54.56.141 (Optional):

Enable NIS (y/n) [n]?

Continue as follows:
For deployment mode 1, go to step 10.
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For deployment mode 2, go to step 7.
For deployment mode 3, go to step 9.

If you are using a VMware server, proceed to Step 8. If you are using a Hyper-V server, you need to
change the configuration on the Windows Server system to promiscuous mode by running the set
promiscuous.psl script, included in the ZIP file containing the virtual engine. When the files are
extracted, the script is saved in the directory to which you extracted the engine. The script enables
the ExtremeAnalytics sensor to see all traffic coming into the interface.

From an Administrator PowerShell on the Windows Server system, enter the following
command to run the script:

.\set promiscuous.psl VM Nameeth]
VM Name - The name of the virtual machine as reported by Get-VM

ethl-The default interface. This entry is optional.

On the ExtremeAnalytics Engine, specify one or more tap ports. For each line, enter the requested
configuration information and press [Enter].

ExtremeAnalytics Appliance Network Configuration for Tap Mode

Enter the interface name for Tap Mode [ethl]: eth4
Would you like to add another interface for Tap Mode (y/n) [n]l? y
Enter the interface name for Tap Mode [eth2]: ethb
Would you like to add another interface for Tap Mode (y/n) [n]? n

Go to step 11.

Specify one or more GRE tunnel interfaces. For each line, enter the requested configuration
information and press [Enter].

ExtremeAnalytics Appliance Network Configuration for Tunnel Interfaces

Enter the interface name for Tunnel Configuration [ethl]: ethi4

Enter information below to configure eth4

Enter the IP address for eth4 on pv88 [10.54.211.116]:

Enter the IP netmask [255.255.255.0]:

Enter the gateway address [10.54.211.1]:

Would you like to add another interface for Tunnel Configuration (y/n)
[n]? y

Enter the interface name for Tunnel Configuration [ethl]: ethb

Enter information below to configure ethb

Enter the IP address for eth5 on pv88 [10.54.222.117]:

Enter the IP netmask [255.255.255.0]:

Enter the gateway address [10.54.222.1]:

Would you like to add another interface for Tunnel Configuration (y/n)
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10. Enter the IP addresses for one or more GRE tunnels. For each line, enter the requested configuration
information and press [Enter]

1.

NAH >
J un
©  q
-
° g
S o
s &
> O
Q o
CH
5 o

(2]
3 =
-Oj
O @
O <
n oS
5> &
s s
U)O
o S
> =
Do =

3
0 2
> 2
;’!—1

S
3 2
Z =
3 9
2 o
o o
-~
~

»)
$ @
g m
33
95
n O
2 g
Q
)
© A
> 8
s 35
_‘(—f
Q =
® @
S g
O ~
D
3 2
> o
=
3
(o]
Q.
()

5Tof 59



Configuring the ExtremeAnalytics Engine

= gl
a ®
= o
o o
o 2.
5
=X Q@
= 2
:
S T
%) [0)
Q n
© >
g (e}
2 5
(%] —+
=} >
Q [0
< O
7 5
- =
3 e
> Z
= z
o 3
o)
()
=t =
® wn
3 &
{'D —_—
2 5
) Q
o) wn
= n
2 0
e [0)
@D
o g
=) o
S g
3 o
] B
S )
)
Q <
= 3
— o
(e} >
8 —
A 3
(o]
Q
)

[Enter].

ExtremeCloud IQ

- Site Engine Console.
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13.

A summary screen displays asking you to accept your SNMP Configuration settings. Enter O to accept
the settings.

The Configure Date and Time Settings screen displays where you are asked if you want to use an
external Network Time Protocol (NTP) server. Enter y touse NTP, and enter your NTP server IP
address(es). Enter n to configure the date and time manually and proceed to step 16.

Note that your VMS server should be using the same NTP settings as those configured
for your virtual engine (i.e., the same settings as the VMs that are hosted on the VMS
server).
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15. The NTP validate selection screen displays. Enter O to accept the current settings and proceed to the
Set Time Zone screen at step 17.

16. If you answered noto using an NTP server to set date and time, the following manual set date and
time screen displays.

17. Enter nat the Use UTC screen.
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18. The Set Time Zone screen displays. Select the appropriate time zone and press [Enter]

19. The Modify Settings screen displays. This screen summarizes the settings you have entered and
provides an opportunity to modify the settings, if desired. Enter O to accept the settings.
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Launching the ExtremeAnalytics Application

The ExtremeAnalytics application software is automatically installed. This could take
a few minutes. When the installation is complete, you’ll see the following screen.

Extreme Networks - ExtremeAnalytics Appliance - Setup Complete

Setup of the ExtremeAnalytics Appliance is now complete.
The appliance is now operational and ready to accept remote connections.

Details of the installation are located in the /var/log/install
directory.

Note: After you have completed the configuration, it is important to take a snapshot
of your engine configuration to be used in the event an engine image reinstall is
required. For instructions on how to take a snapshot, see your vSphere client
documentation.

Launching the ExtremeAnalytics Application

Now that you have configured the ExtremeAnalytics appliance, you are ready to access the
ExtremeCloud 1Q - Site Engine Launch Page and run ExtremeAnalytics from a remote client
machine.

1. Opena browser window on the remote client machine and enter the ExtremeCloud IQ - Site Engine
Launch page URL in the following format: http://<servername>:8080/.
where <servername> is the ExtremeCloud IQ - Site Engine server IP address or
hostname, and 8080 is the required port number. For example:
http://10.20.30.40:8080/.

2. Onthe ExtremeCloud IQ - Site Engine Launch Page, select OneView.
Note: The first time you attempt to launch an ExtremeCloud IQ - Site Engine
application, you will be prompted for the license text you received when you
generated your ExtremeCloud IQ - Site Engine product license.

At the login window, enter your ExtremeCloud 1Q - Site Engine user name and password.
4. Onthe ExtremeCloud IQ - Site Engine screen, select Analytics at the top of the screen.

5. Select Dashboard.
The Dashboard tab displays.

Adding the ExtremeAnalytics Engine

To add the ExtremeAnalytics engine to ExtremeAnalytics:

1. Select the Analytics Configuration tabAnalytics Configuration tab

2. Openthe drop-down list below Overview and select Add Engine.
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Changing ExtremeAnalytics Engine Settings

3. Enter the following information:

« [P address of the ethO interface

o Name of the ExtremeAnalytics engine
4. From the Profile list, select the appropriate SNMP profile.
5. Select OK.

6. Openthe drop-down list below Overview and select Enforce Engine.

Changing ExtremeAnalytics Engine Settings

Use these steps if you need to change your ExtremeAnalytics virtual engine settings following
your initial engine configuration. Perform these steps in the vSphere client Console tab.

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP address, enter

the following command at the login prompt in the Console tab:
/usr/postinstall/dnetconfig

This will start the network configuration script and enable you to make the required changes.
You mustreboot the engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as SNMP Trap Community String, SNMP User,
SNMP Authentication, and SNMP Privacy credentials, enter the following command at the login

promptin the Console tab:
/usr/postinstall/snmpconfig

This will start the SNMP configuration script and enable you to make the required changes.

Changing Date and Time Settings

To enable or disable using NTP to configure the engine date and time, or to manually set the
date and time on the engine, enter the following command at the login promptin the Console

tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the settings.

Changing the ExtremeAnalytics Server IP Address
To change the IP address of the ExtremeAnalytics server, enter the following command at the

login promptin the Console tab:
/opt/appid/configMgmtIP <IP address>
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Then, start using the new ExtremeAnalytics server by typing: appidctl restart.

Changing the Web Service Credentials

The Web Service credentials provide access to the ExtremeAnalytics Appliance Administration
web page and the web services interface for the ExtremeAnalytics engine. Engines are shipped
with a preconfigured default password.

If you have changed the credentials in the Analytics tab and then install a new engine thatis
using the default password, you will not be able to monitor or enforce to the new engine until
you change the password on the engine using this command. The credentials you enter on the
engine must match the credentials specified in the Web Credentials section in Analytics >
Configuration > Configuration.

To change Web Service credentials, enter the following command at the login promptin the
Console tab:
/opt/appid/configWebCredentials <username> <password>

Then, restart the engine by typing: appidctl restart

Upgrading ExtremeAnalytics Engine Software

Upgrades to the ExtremeCloud |Q - Site Engine engine software will be made available from the
Network Management Suite (NMS) Download webpage.

Prior to performing an upgrade, you can create a snapshot of the engine that you can revert to
in the event an upgrade fails. Refer to the vSphere client documentation for instructions on
creating a snapshot.

1. Ona system with an Internet connection, go to the Network Management Suite (NMS) Download web
page: http://extranet.extremenetworks.com/downloads/pages/NMS.aspx.

2. After entering your email address (username) and password, follow this path to the download page:
Visibility & Control > Network Management Suite (NMS) > Software > select a version.

3. Download the following ExtremeAnalytics virtual engine file from the NMS Downloads section:
purview appliance upgrade to <version>.bin
Use FTP, SCP, or a shared mount point, to copy the file to the ExtremeAnalytics virtual engine.

SSH to the engine.

Cd to the directory where you downloaded the files.

~N o u A

Change the permissions on the upgrade file by entering the following command:

chmod 777 purview appliance upgrade to <version>.bin

8. Runthe install program by entering the following command:

./purview appliance upgrade to <version>.bin

The upgrade automatically begins. You are notified when the upgrade completes.
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Reinstalling ExtremeAnalytics Engine Software

Reinstalling ExtremeAnalytics Engine Software

In the event that a software reinstall becomes necessary, it is recommended that you restore an
engine snapshot that you previously made using the vSphere client. Refer to the vSphere client
documentation for instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you will need to re-deploy and reconfigure the
ExtremeAnalytics virtual engine following the instructions in Engine Deployment and this
section.

Note: The re-installation procedure reformats the hard drive, reinstalls all the
ExtremeAnalytics engine software, the operating system, and all related Linux packages.
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